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Spreadsheets using Microsoft Works

Lesson 1
Data entry and editing.

Run Microsoft Works by double  clicking on  it’s Icon.
Select the Spreadsheet icon and click New.

When Works spreadsheet is run, click in Cell  A1  to make it  the
active cell.  This is indicated by a shadow around the cell.
Type your first name. As you type, your name appears on the Formula
bar at the top of the screen and in cell A1.
When you have finished typing, press the return key. This enters the
text into cell A1 and clears the formula bar.
Press the right arrow key once. - Cell B1 is highlighted.
Type your second name and press return.
You first and second names now appear side by side in cells A1 and
B1.

Text entry
Type the following piece of text into the respective cells remembering
to hold down the shift key for capital letters.
Do not worry about errors for the moment they can be corrected later.

Wages A3
CommissionA4
Odd jobs A5

Rent A7
Gas A8
Electricity A9
Phone A10
Going out A11

Week 1 B2
Correcting errors

Read back over what you have just typed and look for errors.
If you spot an error use the mouse to move the highlight to the cell
containing the error and re-type the entry.
Move on to the next error.

Saving your work
Move the mouse pointer to the word File on the Menu Bar.
Click the button.— A menu appears.
Continuing to hold the button drag the mouse down to the word Save
and let go. — A dialogue box appears.
Type the the letters SS followed by your initials and the number one as
a file name.  E.G. John Murphy would type SSJM1.  Do not use
spaces or punctuation marks in file names.
Click on the word Save in the dialogue box.

Quiting from Works.
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Click on the word File in the Menu Bar.
Drag the mouse down until Quit is highlighted let go of the button.
If the message “Save  changes to SSJM1” appears click on Yes.

Lesson 2
Opening files and more editing.

Click on the Icon for Works. Select the spreadsheet icon to start the
spreadsheet.
Click on the word File in the Menu Bar. — a
menu pops down.
Drag the mouse downwards to select the word
Open...
A dialogue box appears containing a list of
available files.
Select your file by clicking on it’s name and
click on the word Open. After a short delay
your file should appear on screen.

Inserting a new row
A title at the top of the sheet would look well,
but there is no available space to fit it in.  We

need to insert a blank row in place of row 2.
Click the mouse on Cell A2 and drag across the width of the screen to
select all the visible cells in row two.
Click on Edit in the menu bar.
Click on Insert.

Inserting a title.
Use the mouse to position the insertion point in cell D1-Type Weekly
and press return.
Move to cell E1 and type Budget and press return.
Move to cell F1 and type Account and press return.
Entering Data:
Move the highlight to cell B4 and type 90 for Wages.
Move down to B5 and type 30 for Commissions.
Move down to B6 and type 15 for Odd jobs
Move down to B8 and type 20 for Rent.

Enter 10 for Gas, 7 for electricity, 3.50 for telephone and 15 for going
out.

Check the above text for errors and correct them as before.

Save the file .

Quit from Works
Lesson 3
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Adding more text and printing.

Run Microsoft Works and  open the file used in lesson 2.
If you can’t remember how look at the start of lesson 2.

Adding more headings.
We want to extend this sheet to cover the month so add new headings
as follows:
In cell C3 type Week 2, and in cells D3 and E3, type Week 3 and
Week 4.

Read the new additions you have made to the document and correct
any errors.
Save the changes to your document.

Entering more Data
Wages don’t change from week to week so Week 1 wages can be
copied across.  This is how it is done:

Highlight cell B4 , which is the cell we want copied.  Drag across to
include C4, C5,and C6, the cells we want to copy to.
Click on Edit to show the Edit menu.
Click on Fill right
90 appears in each cell.

Entering values for Rent, Gas and Electricity.
Rent, gas and electricity don’t change from week to week and you can
copy their entries just as we did for wages.

Entries for Commission, Odd jobs,
Phone and Going out do change so
they are typed in one by one.

Enter these values:
NameSurname

Weekly Budget Account
Week 1 Week

2 Week 3 Week
4

Wages £90 £90 £90 £90
Commission £30 £18 £12 £26
Odd Jobs £15 £34 £12 £0
Rent £20 £20 £20 £20
Gas £10 £10 £10 £10
Electricity £7 £7 £7 £7
Phone £3.50 £3.00 £5.50 £4
Going Out £15 £23 £12 £18
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Printing the document.
When you are satisfied that the document is free of errors, it is time to
print it.

First check that you are connected to the printer by doing the following:
Click on the Œ symbol on the menu bar.
Drag down to Chooser on the menu.
Click on QMS-PS  410 to select the LaserWriter as the printer.
Click on the Go-Away box to get rid of the dialogue box.

Send the document to the printer:
Click on File to select the file menu.
Drag down to Print and release.
A dialogue box appears.  No changes should be necessary so click
Print.
After a short delay your document will print at the printer.

Quit from Works.

Lesson 5
More Headings

Our  spreadsheet might be easier to follow if we had headings like
income ,outgoings and totals  Before we can add these we need to
make space with some more blank rows.

Inserting Rows
Highlight Row 4 by clicking on the Row 4 heading.
Click on Edit to see the edit menu.
Click on Insert to select the insert command.
A new row is inserted.

By the same method insert two new rows at Row 8

Type Income into cell A4.
Type Total Income into Cell A8.
Type Outgoings into cell A10
Type Total Outgoings into cell A16.
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Save the Spreadsheet.
Print the spreadsheet.
If you can’t remember how lookup the previous lesson.

Changing Cell Width
Because of the length of some of our new entries in column A they can
not be read too easily.  This can be solved by changing the width of the
column.

Select Column A by clicking on the column A headline.
Click on Format to show the Format menu.
Click on Column Width to select the column width command
Experiment by entering new widths and see what effect they have on
the column.

Calculations.
The usefulness of a spreadsheet lies in it’s ability to do calculations
Let’s get it to do some.

Total Income for Week 1
Highlight the cell where the answer is to be. in this case B8.
Type =
Highlight the first item in the formula in this case B5
Type +
highlight the second item in this case B6
Type +
Highlight the third item in this case B7
This is the last item so do not type + press return instead.
As you were typing the formula built up on the formula bar and in he
cell.  When you pressed return the cell displayed the answer as £135,
but the formula bar continues to show the formula - =B5+B6+B7

Find the totals for the outgoings for Week 1 by the same method.

Finding Totals for Week 2, Week 3 and Week 4.
We could calculate the total for the other three weeks individually but it
is easier to Copy from week 1

Highlight Cell B8 ( the one that contains the formula for Week 1 Total
Income) and C8, D8 and E8, the cells we want the formula in.
Click on Edit to show the Edit menu.
Click on Fill Right

New Heading
We do not have any entry to tell us whether we are in the Red or the
Black at the end of each week.  Let’s create a new entry called Whats
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Left.

Highlight cell A18 and type Whats Left

Entries for Whats left.
Highlight cell B18 type  =
Highlight cell B8 type  -
Highlight cell B16  press return
The difference between Total Income and Total outgoings will appear
in cell B8

Use theFill Right  to find Whats Left for the other three weeks.
Save and Print the sheet.

Lesson 6
Formatting

Click on the Icon for Works and  start the spreadsheet.
Click on the word File in the Menu Bar. — a menu pops down.
Drag the mouse downwards to select the word Open...
A dialogue box appears containing a list of available files.
Select your file by clicking on it’s name and click on the word Open.
After a short delay your file should appear on screen.

When text is entered into a cell it is aligned to the left of the cell.  When
numbers or formulas are entered they are aligned to the left.  by default.
This is referred to as general alignment.  If we wish we can change this
alignment.  The headings  Income  and Outgoings do not stand out from
the sub-headings.  One way of getting them to stand out is to change
their alignment.  In the next exercise we will leave the headings left
aligned but change the sub-headings to right aligned.  The titles Week 1
etc. will be centred.

Changing Alignment.
Highlight cell A5, the one containing the word Wages
Click on Format in the menu bar.
Click on Set Cell Attributes
Click Right
Click O.K.

Align Commissions and Odd jobs to the Right

Changing the alignment of a range of cells together:
Select cells A11 to A15 i.e Rent to Going out.
Click on Format in the menu bar.
Click on Set Cells Attributes
Click Right
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Click O.K.

Select cells B3 to E3 i.e Week 1 to Week 4.
Click on Format in the menu bar.
Click on Set cell Attributes...
Click Centre
Click O.K.

Changing Style

Using different styles (bold or italics) can also emphasise parts of the
sheet.

Highlight Weekly Budget Account
Click on Format in the menu bar.
Click on Set Cell Attributes
Click Bold
Click O.K.
Change the sub-headings Income, Total Income, Outgoings, Total
Outgoings.into bold type.
Put your name at the top of the sheet into bold.

Formatting Money
Money can be formatting a number of different ways e.g. showing the £
symbol or not.  Showing different numbers of decimal places etc.
Formatting all cells containing money to two places of decimals.

Select all the money cells.
Click Format
Click Set Cell attributes
Click Currency

Save and Print the sheet.

Lesson 7
Using more Functions.
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Run Microsoft Works and  open the file used in lesson 6
If you can’t remember how look at the start of lesson 2.

Adding more headings.
We want to extend this sheet to cover the monthly averages for Wages,
Commissions etc.  Along with the Maximum values and Minimum
values,so add new headings as follows:
In cells H3, I3 and J3 type Monthly,
and in cell H4 Type Average
cell I4 Maximum
Cell J4 Minimum.
Format these in bold type and centre them.

Highlight cell F4 type =Average(B4:E4) and press return.

Use the Function Average  and the respective names to find average
monthly wages commissions etc.
Use the Function Max to find the maximum in each case
Use the  function Min to find the minimum. in each case.

Check the new additions you have made to the sheet and correct any
errors.
Save the changes to your sheet.
Print the sheet.

If you have time experiment with these function but do not mess up
your sheet.

A range of functions are avasilable in works, some are listed below, a
complete list can be obtained by selecting Edit, Paste Function.

Functions
Sum(list) Adds all the numbers in a list.
Product(list) Multiplies all the numbers in a list.
Average(List) Finds the average of a list of value
Min(list) Finds the minimum value in a list.
Max(list) Finds the maximum value in a list.
Count(list) Counts the number of entries in a list for numbers

only.
Counta(list) Finds the number of entries in a list for alphabetics.

Quit from Works
Lesson 8

Using the sheet

You have now designed a useful sheet.  Usually the designer of a sheet
and the user are two different people.  Frequently the user will only
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enter data into a pre-designed sheet.  Therefore it is necessary to
protect the sheet against accidental changes by the user.  We can
protect all cells and therefore only let the user look at the sheet not
make entries, or areas of the sheet can be left unprotected thereby
letting the user change data but not formulas or labels.

Protecting the sheet
Select all the title in column 1
Click on Options
Click on Protected
Select all the labels (Week 1, etc) Protect these.
Select all cells containing formulae, protect these also.

Try entering data into the data cells. This is possible.
Try entering changes to a formula or label cell.  This is  not allowed.

Lesson 9
Further Formatting

When your spreadsheet  is displayed on screen  gridlines are visible.
These can sometimes be distracting and take your attention away from
the information that is being displayed.  Attention can be drawn to
particular aspects of the sheet by the use of borders.

Removing gridlines.
Click on Options.
Click on Show grid

Adding Borders
Works Spreadsheet has the drawing tools which you have already used
in Works Word Processor available.  Select  Edit, Draw on.. to
access the toolbox.

Add an outline border to the groups of cells the following
Total Outgoings i.e A16 to E16
Whats Left i.e. A18 to E18
Monthly Totals, Monthly Averages , Monthly Maximums and Monthly
Minimums. i.e. G3 to J18

We now have the sheet displayed the way we want it.
Page setup.

Click on File.
Click on Page Setup.

There are a large number of options here   Lets just look at some of
them.

Header:  When you print a sheet  the name of the file is printed at the
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top.  The code &f tells it to do this.  If you do not  want this to print
delete it from here.  If you want something else to print type it in here.

Footer: When you print a sheet  the page number is printed at the
bottom of the page.  The code &p tells it to do this.  If you do not
want this to print delete it from here.  If you want something else to
print type it in here.

Margins:  The margins can also be reset here but do not make them
too small, printers cannot print right to the edge of the page.

Click on OK.

Print Preview
A print preview can often save you printing a sheet which is is not as
you want it, so lets preview this sheet before printing:

Click on File.
Click on Print.
Click on Print  Preview.
After a short delay a full page version of your sheet can be seen.  Usu-
ally text cannot be read on a page preview.  A eyeglass allows you to
get a closer view of parts of you sheet.  Zoom allows you to zoom
back to full page view.
If you are not happy with the layout Cancel will return you to the sheet.
If you are satisfied click on Print  to print the sheet.

Lesson 10
Charts

In Microsoft Works charts are created by keying the data into a
spreadsheet first and then creating a chart using selected data from the
spreadsheet.

Type the days of the week (Monday to Friday) into cells B1 to F1.
Type Sales into cell A2.
Type the numbers £1200, £1350, £1260, £1500, £1560  into cells B2
to F2.
Select cells A1 to F2 i.e labels for weekdays, label for sales, sales data.
Click Chart, New Series Chart,
A dialog appears.
For First Row: type 2
From Column: type B
To Column: type f
and click Plot it.

Works creates a column chart using Sales a the Chart Title, the days of
the week as the Category Axis(X-axis) and the amounts of money as
the Value Axis.
Often the chart is entirely satisfactory as shown.
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Print the chart.

Create a Pie chart
Type
Month into cell  A1
January into cell A2
February into cell A3
March into cell A4
April into cell A5

1200 into cell B2
500 into cell B3
1300 into cell B4
750 into cell B5

Highlight cells A1 to B5
Select Chart, New Pie Chart...
Key in the following values:

Plo t  va lues in co lumn:P lo t  va lues in co lumn:P lo t  va lues in co lumn:P lo t  va lues in co lumn:P lo t  va lues in co lumn: BBBBB

From row:F rom row:F rom row:F rom row:F rom row: 22222

Through row:Through row:Through row:Through row:Through row: 55555

Co lumn o f va lue t i t l es :Co lumn o f va lue t i t l es :Co lumn o f va lue t i t l es :Co lumn o f va lue t i t l es :Co lumn o f va lue t i t l es : AAAAA

You can change the chart type using Chart, Select Chart definition, Can
you work out how to do it.

Adding Chart titles.
First we are going to call up the first chart you plotted and then make
changes to it.

Click on Chart, SelectChart Definition:
Select Untitled Chart 1 from the list
Click OK
Key in the following:

Char t  T i t l e :Char t  T i t l e :Char t  T i t l e :Char t  T i t l e :Char t  T i t l e : Week ly Sa lesWeek ly Sa lesWeek ly Sa lesWeek ly Sa lesWeek ly Sa les

Ver t i ca l   Sca le t i t l e :Ver t i ca l   Sca le t i t l e :Ver t i ca l   Sca le t i t l e :Ver t i ca l   Sca le t i t l e :Ver t i ca l   Sca le t i t l e : Days o f weekDays o f weekDays o f weekDays o f weekDays o f week

Hor i zon ta l  Sca le T i t l e :Hor i zon ta l  Sca le T i t l e :Hor i zon ta l  Sca le T i t l e :Hor i zon ta l  Sca le T i t l e :Hor i zon ta l  Sca le T i t l e : M i l l ons o f  poundsMi l l ons o f  poundsMi l l ons o f  poundsMi l l ons o f  poundsMi l l ons o f  pounds

Exercise: Plot a line chart from the following values.

Irish 50%
English 58%
Maths 62%
French 65%
Science 67%

Use chart title: John's results
Vertical scale title: Percentage
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Horizontal sclae title: Subjects
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